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Documentation Roadmap

Documentation Roadmap
Use these publications to learn how to install and use URT:

• Using the User Registration Tool (DOC-785461=)—Describes how to plan for URT
deployment, install URT, how to use URT, and how to troubleshoot network problems
related to URT.

• URT online help—Contains all of the information available inUsing the User
Registration Tool. This ensures you have complete information even if you do not have
the manual readily available while using URT.

Note The online help and hardcopy manual have not been updated for URT 1.2.1. This
release note is included in the online help inHelp>What’s New in URT 1.2.1. Due to the
changes in URT 1.2.1, some information in the online help is no longer correct. Information
in this release note overrides the information in the online help and manual.

New Features
These sections describe the new features in the URT 1.2.x releases:

• New Features in Release 1.2.1, page 2

• New Features in Release 1.2, page 4

New Features in Release 1.2.1
These capabilities have been added to URT for release 1.2.1:

• Ability to delete ClientService for Win9x clients from a batch file—You can now
remove ClientService from Win9x clients.

• Support for New CiscoWorks2000 Releases—URT now works with the CWSI
Campus 2.4 release as well as the 2.3 release.

• Full Support for Host-Based Dynamic VLANs (MAC-Based VLANs)—In previous
versions of URT, you could implement dynamic VLANs based on MAC address only
by creating the VLAN mappings in the CWSI Campus User Tracking application and
then updating the URT servers with those mappings. With URT 1.2.1, you can create
these “host-based” dynamic VLANs from within URT. This change provides more
complete and reliable host-based VLANs. This new support is described fully in the
“Implementing Host Registration” section on page 5.
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New Features in Release 1.2.1

• Support for Additional Switches—URT now works with Catalyst 3500XL and
Catalyst 6000 family switches. The Catalyst 3500XL switches require software release
11.2(8) SA5 or higher. The Catalyst 6000 switches require software release 5.3.1 or
higher.

Note With 2900XL and 3500XL switches that are clustered, URT configures VMPS
on the cluster’s command switch. If the command switch becomes unavailable, URT
cannot manage logins for clients connected to the other switches in the cluster (the
command switch manages VMPS for the other switches in the cluster). When you
resolve the availability problem with the command switch, URT will work properly
again. If you cannot resolve the command switch problem, you must configure VMPS
on each switch in the cluster to regain URT management of logins.

• Support for Additional User Clients—You can now use user registration with
Windows2000 Workstation or Server.

Note The Release IP Address on the Logout option does not work on Windows 2000
clients. The Windows 2000 clients cannot release their IP address during logout.

You can use host registration with any client that has a MAC address that is directly
connected to a supported switch (for example, UNIX, Linux, and Apple Macintosh).

• URT Server Support on Windows 2000—In addition to Microsoft Windows NT 4.0,
the URT server is now supported on Windows 2000 Server edition.

• Support for Active Directory—URT now supports Microsoft’s Active Directory. In
URT, Active Directory support is identical to the existing support for Microsoft
Networking users.

Note URT’s support for Windows 2000 and Active Directory were tested on Microsoft’s
RTM (Release to Manufacturing) version of Windows 2000. If there are significant changes
to the final version of Windows 2000, these changes might affect URT’s support for
Windows 2000 and Active Directory. Cisco will work to resolve any issues related to
changes in Windows 2000 from RTM to the commercially available version.
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New Features

Caution It is important to note that CiscoWorks2000 CWSI Campus doesnot
support Windows 2000. Therefore, the URT administrative interface cannot be
installed on Windows 2000.

• Improved Feedback—When you select an item in the tree view, the status bar shows a
count of the items in the selected folder. For example, if you select the VLANs folder,
the status bar shows the number of VLANs defined in the URT database. This can be
helpful when you are managing a large number of resources.

• Improved List Management—You can now sort the lists shown in the right-hand list
pane. When you click the heading of a column, the list is sorted according to the
contents of the column. Each time you click the heading, the sorting toggles between
ascending or descending order. (The first time you click the heading, the list is sorted in
ascending order).

• Ability to Delete URT Servers from the Folder Pane—You can now delete
unavailable URT servers from the list of servers in the folder pane. To delete the
unavailable server (shown with an X through the icon), select it and selectEdit>Delete.
If the server is temporarily unavailable, it will reappear in the list when it becomes
available.

• Bug Fixes—URT 1.2.1 includes fixes to these significant bugs (other minor bugs might
also have been fixed):

— CSCdp03975—100% CPU consumption in URT server

— CSCdp03977—DHCP release/renew required when client service starts

— CSCdp03981—Support needed for the 3500XL switch

— CSCdp13690—Incorrect VLAN assignment with Windows 95 and Windows 98
users and groups because of case-sensitivity of names.

— CSCdp43437—Performance issues when starting a URT server with a large
number of user and group mappings. Performance has been improved.

New Features in Release 1.2
These capabilities have been added to URT for release 1.2:

• Support NetWare User Logons—You can now use URT to control user logons for
Novell NetWare 5 networks.
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Installing URT

• Support for CiscoWorks2000—URT 1.2 works only with the CWSI Campus 2.3
application suite included with CiscoWorks2000. You cannot use URT 1.2 with CWSI
2.1 or CWSI Campus 2.2.

• Support for Additional Switches—URT now works with Catalyst 1900 and 2800
series switches, Catalyst 2900 series XL switches, Catalyst 2948G switches, Catalyst
4000 series switches, and Catalyst 4912G switches, in addition to Catalyst 2926 series
switches and Catalyst 5000 series switches. SeeUsing the User Registration Tool for
the required software versions for these switches.

Installing URT

Caution URT 1.2.1 works only with the CWSI Campus 2.3 or 2.4 application
suite that is included with CiscoWorks2000. Do not attempt to use URT 1.2.1 with
any other version of CWSI or CWSI Campus. You must install CiscoWorks2000
CWSI Campus before installing URT.

Read the planning and installation information in theUsing the User Registration Tool
manual before installing URT. For URT 1.2.1, the installation process no longer asks
whether you want to continue to use MAC-based (host-based) VLAN associations. URT
1.2.1 automatically enables MAC-to-VLAN mappings.

Implementing Host Registration
This section describes the host-based dynamic VLAN support incorporated in URT 1.2.1.
Host-based VLANs use MAC addresses instead of user names to determine the VLAN
assignment.

• Overview of Host Registration, page 6

• Types of Hosts That Can Be Registered, page 6

• Priority of User Registration vs. Host Registration, page 7

• Deciding Whether to Use User Registration or Host Registration, page 7

• URT’s Relationship to CiscoWorks2000 User Tracking, page 8

• Mapping Hosts to VLANs, page 9

• Using Switch-Based VMPS Servers for Host Registration, page 12
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Implementing Host Registration

Overview of Host Registration
URT’s main capability is to assign users to VLANs. This allows you to develop
VLAN-based services and ensure that users always get the expected services. As users
move from machine to machine in your network, URT can identify the user based on user
name and make the appropriate VLAN assignment.

However, URT does not support user-based assignment on all computers. In some cases,
such as UNIX, this is because a single machine can support multiple simultaneous users,
whereas the associated switch port can be in only one VLAN at a time. In other cases, there
is not an appropriate network login that can be captured by the URT client.

Host registration allows you to assign VLANs based on a host’s media access control
(MAC) address, which is the number associated with the network interface card (NIC) in
the computer. Because the VLAN mapping is based on MAC address, it is the host that is
mapped to a VLAN, not the user.

However, if you have a one-to-one correspondence between users and hosts (that is, users
do not move between hosts), then host registration and user registration will provide
essentially identical network policy control. Also, because the VLAN is based on the host’s
MAC address rather than the switch port, you can move the host to a different port (for
example, move a laptop between buildings) and make the desired VLAN assignment.

Host registration is the same capability as switch-based dynamic VLANs using
CiscoWorks2000 User Tracking and Catalyst 5000 switch VMPS servers.

Types of Hosts That Can Be Registered
You can use host registration with any host that is directly attached to a port on a supported
switch. You cannot use host registration with hosts attached to hubs, unsupported switches,
or routers.

With host registration, you can include Macintosh, Linux, UNIX, and other types of hosts
in your dynamic VLAN planning. You can also use host registration with Windows
machines, even if the Windows version supports user registration.
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Priority of User Registration vs. Host Registration

Priority of User Registration vs. Host Registration
User registration always takes precedence over host registration. URT applies VLAN
assignments in this priority order:

1 User name—If you assign a specific VLAN to a user name, that VLAN is used.

2 NT or Active Directory group, or NDS organizational unit membership—If a user
name does not have an assigned VLAN, and the user name is a member of an NT or
Active Directory group, or NDS organizational unit, URT uses the VLAN assigned to
the group or organizational unit (if there is one).

3 MAC address—If a user name does not have a VLAN assignment, and the user name
is not a member of a group or organizational unit that has a VLAN assignment, then
URT uses the VLAN assigned to the MAC address of the machine (host registration).

Note For clients that do not support user registration, only the MAC address VLAN
assignment is checked.

4 Logon VLAN—If there are no VLAN assignments for user name, group name,
organizational unit, or MAC address, the user remains in the logon VLAN.

Deciding Whether to Use User Registration or Host Registration
In many cases, you do not have a choice between user and host registration. If you want to
use dynamic VLANs for hosts that do not support user registration, you must use host
registration.

For those clients that support both user and host registration (Windows 95, Windows 98,
Windows NT 4.0, and Windows 2000), consider these points when deciding between user
and host registration:

• User registration lets you create policies based on user name. It does not matter to which
host the user logs in, the user gets the same network resources. User-based policies work
well with a mobile or changeable user base.

• User registration requires that you use TCP/IP with Microsoft Networking or Novell
NetWare running over IP. If you do not want to use TCP/IP as your base protocol, you
must use host registration.
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Implementing Host Registration

• You can mix user and host registration freely in the same network. They are
complementary capabilities. You can even use both capabilities on the same machine by
mapping the host’s MAC address to a VLAN. If a user with a VLAN mapping uses the
host, the user gets the user-based VLAN. If an unmapped user uses the host, the user
gets the host-based VLAN. Thus, for “open use” machines you can define a more
restrictive host-based VLAN while giving trusted users their normal user-based VLAN
resources.

URT’s Relationship to CiscoWorks2000 User Tracking
Using the User Registration Tool describes the interaction between URT and User
Tracking. With URT 1.2.1, there is increased interaction.

Each time you start URT, URT reads the User Tracking tables. Any new
MAC address-to-VLAN mappings in User Tracking are added to the URT MAC Address
list in the folder pane. However, if a MAC address already has a VLAN assignment in URT,
any assignment for that address in User Tracking is ignored. Thus, when you start
managing a MAC address in URT, you must continue managing it within URT (unless you
explicitly remove it from URT).

If you make new mappings in User Tracking while URT is running, you can import that
new mapping into URT by selecting the MAC address folder in URT and then selecting
View>Refresh. All new non-conflicting mappings are added to URT.

When URT reads the User Tracking tables, URT also obtains a list of discovered MAC
addresses. When you add a MAC-to-VLAN mapping in URT, URT presents you with a list
of these discovered but unmapped addresses. To get an up-to-date list of MAC addresses,
Cisco recommends that you do a discovery in User Tracking before starting URT when you
intend to work with MAC addresses.
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Mapping Hosts to VLANs

Mapping Hosts to VLANs
These sections describe the tasks for implementing host registration:

• Adding MAC Addresses and Host Mappings, page 9

• Changing Host Mappings, page 12

• Deleting MAC Addresses and Host Mappings, page 12

Adding MAC Addresses and Host Mappings
The list of MAC addresses in the main URT window displays only MAC addresses for
which there are VLAN mappings. Although URT is aware of all MAC addresses discovered
in the network by CiscoWorks2000 User Tracking, you can add only those addresses for
which you are creating mappings to the main window list.

URT automatically adds any MAC addresses that have been mapped to VLANs in User
Tracking to the URT main window.

Before You Begin
Before you start URT to create MAC-to-VLAN mappings, start the CiscoWorks2000 User
Tracking application and do a host discovery. User Tracking will collect data on all the
MAC addresses it can find in your network. URT displays this information so that you can
select MAC addresses from a list. By priming the list of MAC addresses, you will not need
to manually enter the MAC addresses.

Procedure
Step 1 Select the MAC Addresses folder in the URT folder pane and click theAdd

button (or selectEdit>Add ).

URT opens the Host Association window (Figure 1). URT displays all
unmapped MAC addresses found by User Tracking in the Discovered MACs
list. If a MAC address is already mapped to a VLAN, it is not displayed in the
list (mapped MAC addresses are only displayed in the main URT window).
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Implementing Host Registration

Figure 1 Adding MAC Address Mappings

Step 2 Select the MAC addresses you want to map to a particular VLAN in the list of
discovered addresses, and clickAdd>> to add them to the selected MACs list.
You can map more than one address at a time, but all MAC addresses in the
selected MACs list are mapped to the same VLAN.

You can scroll through the list of addresses quickly by typing the MAC address
into the Enter a MAC address field (this is shown in Figure 1). As you type, URT
scrolls through the list of discovered MACs to the next address that matches
what you have typed. Eventually, the address you are looking for will be
highlighted, unless it is an undiscovered address.

30
17

7
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Mapping Hosts to VLANs

If the desired address is not in the discovered MACs list, enter the entire MAC
address in the edit box and clickAdd>> to add it to the selected list. URT does
not require that User Tracking discover the MAC address.

You must use hyphens to separate the bytes in the MAC address; you cannot use
colons.

Step 3 When you have selected all of the MAC addresses you want to map to the same
VLAN, select the VTP domain and the desired VLAN and clickOK .

Tips
• You can select a range of MAC addresses using Shift+click, or multiple individual

addresses using Ctrl+click. All addresses you select must be associated with the same
VLAN.

• You can create different VLAN mappings for each of your VTP domains for each MAC
address.

• When you select a MAC address in the main URT window, the list pane displays the
VLAN mappings for each VTP domain for which there is a mapping.

• When you select a VLAN in the folder pane, URT does not display MAC addresses
mapped to the VLAN.

• You can also add a VLAN mapping in User Tracking. After making the VLAN
assignment in User Tracking and saving the change, select the MAC Addresses folder
in URT and selectView>Refresh. URT finds the new mapping in the User Tracking
table and adds it to the list in URT.
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Implementing Host Registration

Changing Host Mappings
You can change the VLAN mappings for any host that has a mapping, whether the mapping
was made in URT or User Tracking.

Procedure
Step 1 Double-click the MAC address whose mapping you want to change in the MAC

Addresses folder, or:

• Select the address and click theAssociate VLAN button.

• Select the address and selectEdit>Associate VLAN.

URT opens the Associate VLAN window.

Step 2 In the Associate VLAN window, select the desired VTP domain and VLAN and
click OK .

Deleting MAC Addresses and Host Mappings
If you no longer want to use host registration with a host, delete its mappings in URT.

Procedure
Step 1 Select the MAC address you want to delete in the MAC Addresses folder.

Step 2 SelectEdit>Delete.

URT deletes the MAC address and its VLAN mappings.

Note If you delete all the VLAN associations for a MAC address, the MAC address will
not show up in the tree.

Using Switch-Based VMPS Servers for Host Registration
If you want to use switch-based VMPS servers rather than URT servers to manage host
registration, you can still use the URT interface to create the host-based VLAN mappings.

When you save the URT database, URT creates a vmps10.dat file in the dat folder in the
URT installation folder on the URT server machines. See the Catalyst 5000 documentation
for information on implementing switch-based VMPS using this file.



Release Notes for User Registration Tool 1.2.1  13

Mapping Users or Hosts from the Command Line

Deleting ClientService from Win9x Clients from a Batch File
You can now remove ClientService from Win9x clients by using the command
UrtClientUninstall.bat  from the PDC.

Step 1 In the Urt.bat file on the PDC, comment out the line containing
%WINDIR%\\onoffhandler.

Step 2 Execute@start %WINDIR%\\urt\\UrtClientUninstall.bat

Mapping Users or Hosts from the Command Line
URT 1.2.1 includes a command that you can use to add user-to-VLAN or host-to-VLAN
mappings from the command line. This is primarily useful if you have an automated
method of creating a text file with your required mappings. You can pipe this text file into
theurt  command, thus creating mappings using a batch process.

The urt.bat file resides in the bin subdirectory of the CWSI root directory.

The syntax of the urt command is:

urt -cli -server ANI-server-name [ < textfile]

You can get help information by enteringurt -help.

Syntax Description

-cli Indicates that you are running URT from the command line rather
than the GUI.

-serverANI-server-name The name of the ANI server used by CiscoWorks2000.
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Additional Troubleshooting Tips

Additional Troubleshooting Tips
Here are some additional tips to troubleshooting URT. For more tips, see the
troubleshooting chapter inUsing the User Registration Tool.

• “Waiting for ANI” message —URT displays this message while it is trying to connect
to the CiscoWorks2000 ANI server. If this message persists, URT is unable to make the
connection. URT requires ANI services in order to work, so you must resolve this
connection problem. To determine the source of the problem, try these steps:

(a) Try to start CiscoWorks2000 CWSI Campus. If CWSI Campus cannot start, the
ANI connection problem is due to a CiscoWorks2000 problem.

(b) If you can successfully start CWSI Campus, make sure that you installed the URT
CWSI Upgrade package.

(c) If you installed the CWSI Campus package, make sure that you are using the same
ANI server name in CWSI Campus and in URT.

For CWSI Campus, you can find the ANI server name in the
etc\cwsi\ani.properties file. Look for the AniName parameter.

< textfile Optionally, the name of a text file that contains the user-to-VLAN
and host-to-VLAN mappings. If you do not specify a file, you must
enter the mappings at the command prompt after you start the
command. Whether you enter the mappings from a file or the
command prompt, the mappings must be in this format:

• For host-to-VLAN mappings:

MAC-address, VTP-domain, VLAN

• For NT-user-to-VLAN mappings:

NT-domain\username, VTP-domain, VLAN

• For NDS-user-to-VLAN mappings:

NDS-tree\username, VTP-domain, VLAN

Any mappings you enter override existing mappings in the URT
database.

The NT domain or NDS tree must already be defined in URT
through GUI before you can enter mappings for them using the
command line. You cannot add domains or trees through the
command line.
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Documentation Changes

For URT, you can find the ANI server name in the
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\urtsvc registry
entry. Look for the Args parameter.

If the names are different, rerun the URT installation program and enter the correct
CWSI Campus ANI server name when prompted.

• “Network Error: Some Resources Not Available” message on the client—The
“Users Are Getting ‘Network Error: Some Resources Not Available’ Messages During
Logon” section inUsing the User Registration Toolmentions several possible causes of
this problem. There is an additional possibility: check to ensure that your DHCP server
is configured to give out the default gateway address. If the DHCP server does not give
out the gateway (router) address, URT cannot switch the user to the correct VLAN, and
the user remains in the logon VLAN.

Documentation Changes
The user guide and online help for URT was not updated for 1.2.1. A number of changes
made in release 1.2.1 have made certain statements in the 1.2 documentation incorrect. This
section describes these changes.

• URT Server names—URT now lists URT servers by host name rather than IP address.

• Add Domain button and Edit>Add Domain command—This button is now called
Add, and its associated commandEdit>Add . They are now sensitive to the selection
in the tree view. If you select the NT/NDS Domains folder, clickAdd to add a domain.
If you select the MAC Address folder, clickAdd to add MAC addresses and their
VLAN mappings.

• Delete Domain button and Edit>Delete Domain command—This button is now
calledDelete, and its associated commandEdit>Delete. They are now sensitive to the
selection in the tree view. You can select and delete NT or NDS domains, MAC
addresses and their VLAN mappings, and URT servers.

• Configure>Update MAC to VLAN Mappings command—Because URT 1.2.1 now
directly supports host-based VLANs, this command is no longer necessary, and it has
been removed. When you save the URT database, MAC to VLAN mappings are also
saved in the vmps10.dat file on each URT server (in the dat folder in the URT
installation folder).

• Server Options dialog box—The Server Options dialog box (access by
double-clicking a server name in the tree view) no longer includes the Enable
MAC-Based VLANs check box. URT always enables host-based VLAN support.
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URT Known Problems

• Configuring Catalyst 2900XL ports to be dynamic—You might have to use the
Catalyst 2900XL command line interface to make the switch ports dynamic. The
command is switchport access vlan dynamic.

• Helper addresses in router configurations—In Using the User Registration Tool,
“Detailed Example of Network Configuration for URT,” step 3 (Chapter 2), the router
configuration shown includes helper addresses. The sample address is of the machine
that is running the DHCP server. You must configure the helper address to use the
DHCP server for DHCP requests to be completed. This is required by DHCP even if
URT is not used.

URT Known Problems
Known problems are unexpected behaviors or defects in the product. They are graded
according to severity level. These release notes contain information for severity levels 1 and
2 only.

You can search for known problems on the Cisco bug tracking system tool, called Bug
Navigator II. To access Bug Navigator II, do one of the following:

• Enter http://www.cisco.com/support/bugtools in your web browser.

• Log in to CCO and selectServices & Support>Online Technical Support>Software
Bug Toolkit>Bug Navigator II .
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URT Known Problems

Table 1 describes restrictions or other known issues for using URT.

Table 1 URT 1.2 Known Problems

Bug ID Summary Explanation

CSCdp52403 Setting VMPS servers on a Catalyst
4000 switch running CatOS 5.2.2
using the URT management interface

You cannot set VMPS servers on a Catalyst 4000 switch
running CatOS 5.2.2 using the URT management interface.
If you see the message “Cannot set VMPS on the following
switch:”

Step 1 Verify that the SNMP Community string in CWSI
corresponds to the SNMP Community string in the
switch.

Step 2 If this does not help, telnet to the switch and in the
enable mode, enter the command:

set vmps server <IP address of URT Server> [primary]
Please refer to switch documentation for more information
on usage.

This problem does not occur on CatOS version 5.1.64 and
will be addressed in a future CatOS release.

CSCdp50922 Using URT with port channelling set
to mode Off

You cannot use URT with port channelling on a switch set
to mode Off. URT cannot switch the port to the user
assigned or logon VLAN and the port remains in state dyn- .

None Using URT with span VLAN You cannot use span VLAN on a switch with URT. If you
are using span VLAN, you must turn off spanning, then
disable and enable the dynamic switch port.

None Some Win95 PCs may show
Windows blue screen on login

This seems to be a problem with specific PCs running
Windows 95 and OSR2(OEM Service Release 2). However,
if you use OSR2.1 (like Windows 95 4.00.950B), you
probably will not see this problem.

None Uninstalling and reinstalling CWSI
Campus with URT installed

If you are already using URT, and you need to uninstall and
then reinstall the CiscoWorks2000 CWSI Campus suite,
you must first make a copy of the urt.dat file. This file
contains your URT configuration, and CWSI Campus will
delete it during uninstallation. The file is in the db\data\
subdirectory of the CWSI Campus root directory.

After you reinstall CWSI Campus, copy urt.dat back into
the db\data\ subdirectory.
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Cisco Connection Online
Cisco Connection Online (CCO) is Cisco Systems’ primary, real-time support channel.
Maintenance customers and partners can self-register on CCO to obtain additional
information and services.

Available 24 hours a day, 7 days a week, CCO provides a wealth of standard and
value-added services to Cisco’s customers and business partners. CCO services include
product information, product documentation, software updates, release notes, technical
tips, the Bug Navigator, configuration notes, brochures, descriptions of service offerings,
and download access to public and authorized files.

CCO serves a wide variety of users through two interfaces that are updated and enhanced
simultaneously: a character-based version and a multimedia version that resides on the
World Wide Web (WWW). The character-based CCO supports Zmodem, Kermit,

None Changing to a secondary URT
(VMPS) server

In Chapter 1 ofUsing the User Registration Tool, section
“What Happens to User Logons If URT Servers Are
Disabled,” page 1-4, the note says that it takes 5 minutes for
a switch to recognize that the URT server it uses for VMPS
is not available and to change to a secondary URT server. In
fact, it takes8 to 15 minutes for this changeover to occur.

None Catalyst 3500XL switch clustering
feature

URT does not directly support the switch clustering feature.
You must assign each switch an IP address if you want to
configure the switch’s VMPS addresses through URT. If
you use clustering, you must use the switch’s commands to
configure the VMPS server addresses.

None Installing the client service To install the URT client service on Windows NT
workstations, you must log into the CiscoWorks2000-URT
machine with administrative privileges in the NT domain
that contains the Windows NT machines. It is not sufficient
to log into the domain from the URT interface.

None Multi-homed Windows 95 and
Windows 98 systems

URT does work with Windows 95 or Windows 98 clients
that are multi-homed, that is, clients that have more than one
active NIC or an active NIC with an active modem. These
clients must have only one active network connection.

Table 1 URT 1.2 Known Problems (continued)

Bug ID Summary Explanation
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Cisco Connection Online

Xmodem, FTP, and Internet e-mail, and it is excellent for quick access to information over
lower bandwidths. The WWW version of CCO provides richly formatted documents with
photographs, figures, graphics, and video, as well as hyperlinks to related information.

You can access CCO in the following ways:

• WWW: http://www.cisco.com

• WWW: http://www-europe.cisco.com

• WWW: http://www-china.cisco.com

• Telnet: cco.cisco.com

• Modem: From North America, 408 526-8070; from Europe, 33 1 64 46 40 82. Use the
following terminal settings: VT100 emulation; databits: 8; parity: none; stop bits: 1; and
connection rates up to 28.8 kbps.

For a copy of CCO’s Frequently Asked Questions (FAQ), contact cco-help@cisco.com. For
additional information, contact cco-team@cisco.com.

Note If you are a network administrator and need personal technical assistance with a
Cisco product that is under warranty or covered by a maintenance contract, contact Cisco’s
Technical Assistance Center (TAC) at 800 553-2447, 408 526-7209, or tac@cisco.com. To
obtain general information about Cisco Systems, Cisco products, or upgrades, contact
800 553-6387, 408 526-7208, or cs-rep@cisco.com.
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Documentation CD-ROM

Documentation CD-ROM
Cisco documentation and additional literature are available in a CD-ROM package, which
ships with your product. The Documentation CD-ROM, a member of the Cisco Connection
Family, is updated monthly. Therefore, it might be more current than printed
documentation. To order additional copies of the Documentation CD-ROM, contact your
local sales representative or call customer service. The CD-ROM package is available as a
single package or as an annual subscription. You can also access Cisco documentation on
the World Wide Web at http://www.cisco.com, http://www-china.cisco.com, or
http://www-europe.cisco.com.

If you are reading Cisco product documentation on the World Wide Web, you can submit
comments electronically. ClickFeedbackin the toolbar and selectDocumentation. After
you complete the form, clickSubmit to send it to Cisco. We appreciate your comments.

Access Registrar, AccessPath, Any to Any, AtmDirector, Browse with Me, CCDA, CCDE, CCDP, CCIE, CCNA, CCNP, CCSI, CD-PAC, the Cisco logo,
Cisco Certified Internetwork Expert logo, CiscoLink, the Cisco Management Connection logo, the Cisco NetWorks logo, the Cisco Powered Network logo,
Cisco Systems Capital, the Cisco Systems Capital logo, Cisco Systems Networking Academy, the Cisco Systems Networking Academy logo, the Cisco
Technologies logo, ConnectWay, Fast Step, FireRunner, Follow Me Browsing, FormShare, GigaStack, IGX, Intelligence in the Optical Core, Internet
Quotient, IP/VC, Kernel Proxy, MGX, MultiPath Data, MultiPath Voice, Natural Network Viewer, NetSonar, Network Registrar, the Networkers logo,
Packet, PIX, Point and Click Internetworking, Policy Builder, Precept, ScriptShare, Secure Script, ServiceWay, Shop with Me, SlideCast, SMARTnet, The
Cell, TrafficDirector, TransPath, ViewRunner, Virtual Loop Carrier System, Virtual Service Node, Virtual Voice Line, VisionWay, VlanDirector, Voice LAN,
Wavelength Router, Wavelength Router Protocol, WaRP, WebViewer, Workgroup Director, and Workgroup Stack are trademarks; Changing the Way We
Work, Live, Play, and Learn, Empowering the Internet Generation, The Internet Economy, and The New Internet Economy are service marks; and ASIST,
BPX, Catalyst, Cisco, Cisco IOS, the Cisco IOS logo, Cisco Systems, the Cisco Systems logo, the Cisco Systems Cisco Press logo, Enterprise/Solver,
EtherChannel, EtherSwitch, FastHub, FastLink, FastPAD, FastSwitch, GeoTel, IOS, IP/TV, IPX, LightStream, LightSwitch, MICA, NetRanger,
Post-Routing, Pre-Routing, Registrar, StrataView Plus, Stratm, TeleRouter, and VCO are registered trademarks of Cisco Systems, Inc. or its affiliates in the
U.S. and certain other countries. All other trademarks mentioned in this document are the property of their respective owners. The use of the word partner
does not imply a partnership relationship between Cisco and any of its resellers. (9911R)

Copyright © 1998-1999, Cisco Systems, Inc.
All rights reserved.


	Documentation Roadmap
	New Features
	New Features in Release 1.2.1
	New Features in Release 1.2

	Installing URT
	Implementing Host Registration
	Overview of Host Registration
	Types of Hosts That Can Be Registered
	Priority of User Registration vs. Host Registration
	Deciding Whether to Use User Registration or Host Registration
	URT’s Relationship to CiscoWorks2000 User Tracking
	Mapping Hosts to VLANs
	Adding MAC Addresses and Host Mappings
	Changing Host Mappings
	Deleting MAC Addresses and Host Mappings

	Using Switch-Based VMPS Servers for Host Registration
	Deleting ClientService from Win9x Clients from a Batch File


	Mapping Users or Hosts from the Command Line
	Additional Troubleshooting Tips
	Documentation Changes
	URT Known Problems
	Cisco Connection Online
	Documentation CD-ROM

